
Affymetrix Tiling Arrays 
 
Updated:  S. Silverman 6/2011 
Updated by Mark Hickman (Nov 2009). 
Updated by David Gresham and Alex Ward (June 2008). 
This protocol is based on previous protocols developed by Maitreya Dunham, Matt 
Brauer, Justin Borevitz, Elizabeth Winzeler and Affymetrix. 
 
 
Aim: 
This protocol is used to identify SNPs compared to a reference genome (in this case, 
yeast strain FY3).  Briefly, Klenow enzyme is used to incorporate a biotinylated 
nucleotide  in sonicated genomic DNA. The labeling reaction is performed at 25°C, 
which is a nonpermissive temperature for Klenow and therefore limits its processivity. 
Labeled DNA is around 100bp in length and the labeling method results in 
approximately a 7-fold amplification of DNA. This labeled DNA is then hybridized to an 
Affymetrix yeast genome tiling array.  The hybridization results are then processed by 
the SNP scanner program to identify peaks of non-hybridization, representing SNPs 
compared to the reference genome. 
 
Materials: 
 
1. Genomic DNA – DNA must be good quality, DNA prepared using Qiagen Genomic 
Tips is preferred (for enough DNA, use 50mL of saturated culture) 
2. Affy Yeast Tiling Arrays (Reverse) – can be purchased from the microarray facility (~1 
week before experiment). 
3. Invitrogen BioPrime Labeling Kit – Product 18094-011 
4. Reagents for hybridization and washes (see below). 
 
 
Preparing genomic DNA fragments by sonication 

1. Dilute 10 µg of sample genomic DNA in a total volume of 200µL dH2O. (For all 
steps where it is required, measure DNA concentration with Qubit fluorimeter, 
which is more accurate.) 

2. Sonicate DNA using program 4 on the Botstein sonicator (power=1, pulse 
duration= 0.5s, 0.5s off;  total=30s) 

3. Run 15µL on a 1% agarose gel to confirm sonicated product is sufficiently 
sonicated (median size of products ~600bp).  You can run ~1 µg of non-
sonicated genomic DNA for comparison. 

4. Concentrate DNA in a Zymo-5 column: add 1mL of DNA binding buffer to 200µL 
sonicated DNA and mix.  Load onto column 600µL and spin at max speed for 30 
sec.  Load the remaining ~600 µL onto column and spin for 1 min.  Donʼt perform 
the wash step as this results in loss of DNA. Elute in 25uL dH2O (leave dH2O on 
column for 5 min to allow DNA to dissolve). 



5. Determine DNA concentration. 
 
Labeling DNA using Invitrogen BioPrime kit 
 

1. In 200µl thin-walled PCR tube on ice, add: 
• 1000ng of sonicated DNA in a total of 72µl dH2O 
• 60 µl of 2.5X random primer solution (from Bioprime kit) 

2. Denature in PCR block by heating for 8min at 99°, and cooling down (fast ramp) 
to 4° for 8min (Use BioPrime program on PCR machines). Centrifuge briefly. 

3. Add 5µL 10X dNTP mixture (from Bioprime kit) and mix briefly. 
4. Add 3µL Klenow fragment and mix gently but thoroughly by pipeting. 
5. Incubate at 25°C for 16hr and then hold at 4°C (Use program 25for16 in PCR 

machine) 
6. Add 15µl stop buffer (from Bioprime kit). 
7. Transfer the solution to 1.5ml Eppendorf tube and add: 

• 16µl 3M sodium acetate (pH5.2) – mix 
• 400µl cold ethanol 

8. Mix by inverting the tube and place at -20°C for 1-2h to precipitate DNA 
9. Centrifuge at maximum for 10min to pellet DNA and carefully pour off the 

supernatant. 
10.   Add 500ul 80% cold ethanol and place at room temperature for 10min. 
11.  Centrifuge at maximum speed for 10min and carefully remove the supernatant. 
12.   Spin the tube to bring all remaining supernatant to the bottom of the tube, and 

remove supernatant with a 200µL pipette. 
13.  Resuspend the pellet in 50µl ddH2O (mix well, may have to pipet up and down to 

fully resuspend; there will be some insoluble material). 
14.  Run 5µl on 2% agarose gel to confirm tightly distributed band around ~100bp. 
15.  Quantitate DNA and store at -20°C. 

 
 
Hybe Protocol (per Dunham Protocol with some modifications)  
 

1. Bring 3µg of labeled DNA to a total of 133µl with water. 
2. Add: (BSA, Salmon sperm DNA and control oligo kept at -20C) 

• 150 μl 2X hybe buffer (recipe at end of protocol) 
• 15 μl 10 mg/ml BSA (stored at -20°C) 
• 3 μl 10 mg/ml salmon sperm DNA (stored at -20°C) 
• 5 μl 3 nM control oligo B2 (ordered from Affymetrix; see note at end, 

stored at -20°C) 
3. Take tubes on ice downstairs to microarray facility. 
4. Incubate 99°C for 5 min.  While incubating, load array (see loading instructions 

below) with 200 µL 1x hybe buffer (see recipes) and prehybe array in the oven for 
10 min at 45°C, 60rpm.   

5. Incubate probe 45°C 5 min.  (If there is no block or water bath set to this 



temperature, you can put the tubes in the oven). 
6. Spin the tubes 5 min. 
7. Remove the prehybe buffer from the array (see Removing instructions below) 

and load with 200 μl probe, avoiding any debris at the bottom of the tube. 
8. Cover septa with Tough Spots to prevent leakage, and put arrays in oven at 

45°C, 60 RPM for 20 hours. 
9. You can make the Wash Buffers A and B to be used the next day. 

 
 
Loading the Array (for above steps) 

1. Put a 200 μl filter tip in one of the septa as an air release. 
2. Pipet up your solution from a tube with a 200 μl filter tip.  
3. Holding the array so the air release is upward, puncture the other septum and 

slowly pipet in your solution to fill the chamber. 
4. Withdraw the tip. You should have a bubble in the array chamber. 
5. Remove the air release tip. It should not have any solution in it. 
6. Place Tough-Spots on the septa. 
7. Place the array in the plastic holder tray. Snap it into the holders in the oven. 

Balance with another tray. 
 
 
Removing solution from array (for above steps) 

1. Remove the Tough-Spots with forceps. 
2. Place a 200 µl filter tip in one of the septa as an air release. Pierce the other 

septum with a 200 ul filter tip attached to a pipet that is pressed down. 
3. Keep the air release above the septum you are pipetting from, which will allow all 

the solution to accumulate at the bottom.  Pipet out the solution. 
 
 
Washing (including antibody incubations) 

1. Make Wash A, Wash B, SAPE and antibody solutions (recipes below). 
2. Turn on the Affymetix computer and log into Princeton using your Princeton ID 

and password.  Open the GeneChip Operating software.  Turn on Wash station. 
3. Enter new experiments by first going to the File menu and choosing “New 

Experiment”. 
4. Click the Barcode field and scan the barcode on the microarray. 
5. Enter in your sample name the following way: Lab_Initials_Date_Sample (e.g., 

Bot_AW_20070804_FY4).  Copy and paste the sample name into the 
Experiment name field. 

6. For Sample Type field, choose “Yeast” from the pull-down list. For Project Type 
field, choose “Tiling” from the pull-down list. Press Save. 

7. Repeat step 3-6 for each microarray. 
8. Prime the wash station:  Go to the Run menu in the GeneChip Operating 

software.  Choose Fluidics.  A window will open.  Choose “no probe array” as the 



sample.  Choose “Prime450” as the protocol.  This will set the parameters for 
each module (a module accommodates one microarray), but you can select all 
modules if you have 4 arrays.  Fill wash bottles with the appropriate wash buffers 
and fill the dH2O bottle.  Press Run and follow the instructions.  The subsequent 
priming will take ~10 minutes. 

9. After priming is finished, set up the parameters in the Fluidics window for each 
module (array):  Choose your sample from the pull-down list. Select “EukGE-
WS2v4” for the protocol. 

10. Press Run for each module and follow the instructions in the window. Remove 
the ToughSpots from the septa before loading the array into the wash station, 
and be sure to load the correct array into the correct module.  The subsequent 
washing will take ~1 hour and 20 minutes. 

11. After loading the arrays into the wash station, turn on the Affymetrix scanner. 
This gives the scanner time to warm up before you begin scanning. 

12.  When the washing is completed, remove the arrays from the wash station but do 
NOT reengage the washblock. Ensure there are NO bubbles in the array. If there 
are, place the array back in the washblock and engage. Repeat this until there 
are no bubbles. Seal the septa with ToughSpots. 

13. Place the arrays in the scanner, being sure to avoid slot 1 (which is outlined in 
red and should only be used if you are using manual mode). 

14. Scan the arrays by going to the Run menu and choosing Start Scanner.  A 
window will appear.  Make sure the 1st box is checked.  Press OK.  Scanning will 
take ~2 hours for 4 arrays. 

15. Shut down wash station using Shutdown_450 protocol for all modules. Save any 
remaining wash buffer. 

 
 
Data export and SNP scanner 

1. The Affymetrix program generated EPT, DAT and CEL files that are stored in a 
user folder named after your Princeton ID. The folder is located on the hard drive 
of the Affymetrix computer. 

2. Export your data to \\arrayfiles\arraydata\people\XX where XX is your Princeton 
ID, using the following protocol:  Make sure you are logged into the computer with 
your Princeton ID and password. Go to My Computer>Tools>Map Network Drive. 
Choose a drive letter from the drop down menu, and choose 
\\arrayfiles\arraydata as the folder.  Click Finish.  In the Start Menu, open the 
GCOS Manager, go to the Tools menu and choose Set Data Path.  Choose 
\\arrayfiles\arraydata\people\XX as the folder.  In the Process Tab in the left field, 
click Samples, click Universal or Expression, and then double click the 
experiment you wish to export.  In the right field, the experiment will appear.  
Right click on the experiment name and select export.  Exporting will take around 
3-8 minutes; you can tell that it is working because in the lower field it will say 
“running”.  Repeat the export for each experiment and they will be exported 
serially.  When the exporting is finished, the lower field will say “available”. Once 



finished, you can double click on the experiment in the right field, and the DAT 
and CEL files will appear beneath it.  Log out of the computer.  (Do not archive 
your data at this point.  It will be done automatically later on, and if you do 
archive, the CEL file will not be in the correct format for the next steps.) 

3. Establish account on rackett server and copy SNP_Scanner folder to your folder. 
4. Copy CEL file from arrayfiles to rackett:  From Mac finder, connect to server 

smb://arrayfiles/arraydata.  Then open Fugu, a secure file transfer program.  On 
the left part of the window, go to the top directory /.  Open “Volumes”.  Then open 
“arraydata/people/XX”, where XX is your Princeton ID.  On the right part of the 
window in Fugu, open XX@rackett.  The password for rackett is your genomics 
password. Open CEL folder and drag CEL files from left part (arrayfiles) to right 
part of window (rackett). 

5. Run the SNP scanner script using the following steps:  Open a terminal.  ssh to 
your rackett folder using your genomics username and password.  Copy the 
SNP_Scanner1_1 directory from Botlabshare to your directory on rackett using 
Fugu or any file transfer utility.  Type “cd SNP*” and press Enter, which will 
change to that directory.  Type command “./tiling_predict.sh FileName.CEL NO” 
and Press Enter.  The script will take >2 hours to run.  Leave the terminal window 
open.  (Or you can run the script in the background by adding a space and then 
"&" without the quotes to the end of the command.  You can then close the 
terminal window.) The script will create an SGR file in the folder 
“SNP_Scanner_1_1/results” and the name of this file is FileName.SGR.  Also, the 
script will create text files in the folder “SNP_Scanner_1_1/Peaks” that will list the 
significant peaks identified by SNP scanner using a stringent threshold.  (The 
reference genome is FY3, so all mutations identified will be relative to that strain.) 

6. Copy the SGR file to your computer using Fugu.  Download IGB 5.12 to your 
computer (this is an older version but works with the SNP scanner output.)  Start 
IGB; it will run a script off the web.  Open preferences in File menu, select Data 
Sources, make sure QuickLoad is turned on and 
“http://puma.princeton.edu/quickload_data/ “ is in the QuickLoad URL field. Close 
window. Click QuickLoad tab and choose “Personal” as data access and 
“S_cerevisiae_Jul_2007” as genome.  In file menu, select Open File and select 
your SGR files to open.  They will take a few minutes to load.  Using IGB, you 
can verify that the peaks identified by SNP scanner are specific/significant or you 
can identify peaks not picked up by SNP scanner. 

 
 
Recipes 
 
2X Hybe buffer (50 ml total) 
8.3 ml 12X MES (to 200 mM) 
17.7 ml 5 M NaCl (to 2M Na+) 
4 ml 0.5 EDTA (to 40 mM) 
100 μl 10% Tween-20 (to 0.02%) 



19.9 ml dH2O 
Store at 4°C in dark. 
 
Wash buffer A (1 L total) 
300 ml 20X SSPE (to 6X, i.e. 0.9 M NaCl, 60 mM NaH2PO4, 6 mM EDTA) 
1 ml 10% Tween-20 (to 0.01%) 
water to 1 L. 
Filter sterilize. 
 
Wash buffer B (1 L total) 
83.3 ml 12X MES (to 100 mM) 
5.2 ml 5 M NaCl (to 0.1 M Na+) 
1 ml 10% Tween-20 (to 0.01%) 
water to 1 L. 
Filter sterilize. 
Store 4°C in dark. 
 
2X Stain Buffer (250 ml total) 
41.7 ml 12X MES (to 200 mM) 
92.5 ml 5 M NaCl (to 2 M Na+) 
2.5 ml 10% Tween-20 (to 0.1%) 
water to 250 ml 
Filter sterilize. 
Store 4°C in dark. 
 
12X MES (100 ml total) 
6.461 g MES hydrate (to 1.22 M MES) 
19.33 g MES sodium salt (to 0.89 M Na+) 
water to 100 ml 
Filter sterilize. 
pH should be between 6.5 and 6.7. 
Store 4°C in dark. Discard if it turns yellow. 
 
20X SSPE (buy from amresco) 
3 M NaCl 
0.2 M NaH2PO4 

20 mM EDTA 
 
SAPE (These will be stains 1 and 3.  Make 1.2 mL per array.) 
12 μl 1 mg/ml R-streptavidin phycoerythrin (to 10 ug/ml) (Invitrogen S-­‐866) 
240 μl 10 mg/ml BSA (to 2 mg/ml) 
600 μl 2X stain buffer (to 1X) 
348 µl water 
Make the day of use in a 1.5 mL tube. Store in 600 μl aliquots at 4°C in dark until use.  



600 µl will be used as stain 1, and 600 µl will be used as stain 3. 
 
Antibody solution (This will be stain 2.  Make 0.6 mL per array.) 
6 μl  10 mg/ml goat IgG (to 0.1 mg/ml) 
120 μl  10 mg/ml BSA (to 2 mg/ml) 
3.6 μl 0.5 mg/ml anti-streptavidin antibody (goat), biotinylated (to 3 ug/ml) (Vector Labs 
BA-­‐0500) 
300 μl  2X stain buffer (to 1X) 
170.4 µl water 
Make the day of use in a 1.5 mL tube. Store in 600 μl aliquots at 4°C in dark until use. 
600µl will be used as stain 2. 
 
	
  

Part	
  #:	
  900301,	
  Control	
  Oligo	
  B2,	
  3nM	
  

http://www.affymetrix.com/estore/browse/products.jsp?navMode=34000&productId=13
1541&navAction=jump&aId=productsNav#1_1	
  

Use	
  Control	
  Oligo	
  B2,	
  3	
  nM	
  to	
  provide	
  alignment	
  signals	
  for	
  image	
  analysis	
  software	
  
products.	
  

The	
  reagent	
  is	
  also	
  included	
  in	
  the	
  Hybridization	
  Control	
  Kit,	
  part	
  numbers	
  900454	
  and	
  
900457.	
  

	
  

Goat	
  IgG	
  

NC9538546 from ThermoFisher.  
 
OR  Non-immune Goat IgG (Cedar Lane Labs CLGT00, lot IG963R1). stock is 
10mg/ml in 50 % glycerol, store at -20°C  
	
  

 


